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1 Introduction 

1.1 What is GCT v2.1 

The GenICam Control Tool (GCT) permits to communicate with cameras which fulfil the GenICam 
standards. The tool allows to set-up a camera, browse and adjust parameters, perform camera 
calibration tasks and visualize and analyze acquired images. GCTv2.1 is the successor product of GCT 
v1.x. It uses the transport layer interface and provides more features. 

1.2 Installation of GCT v2.1 

The installation program can be downloaded from https://www.chromasens.de/gct2-current 

GCT v2.1 does not require the installation or uninstallation of GCT v1.x. Both can exist parallelly on the 
PC. If GCT v2.x was already installed before, an information will indicate you to overwrite the previous 
version of v2.x. 

GCT2 is a GenICam-based camera tool. It can be used with compatible TL producers (*.cti). 

GCT2 only supports cameras manufactured by the TKH Vision group. 

The transport layer for the different interfaces (1GigE, 10GigE, CoaXPress) are provided by the GCT 
installer. 

There are six components for the installation: 

 

Depending on the kind of interface, different components of the installation are needed.  

For detailed information about the components, you need to install, refer to: 

• chapter 3 for installation with Kithara transport layer, 

• chapter 4 for installation for 10GigE interface without Kithara, or  

• chapter 5 for installation with CoaXPress interface. 

The operation of GCT is always the same regardless of the interface. 

1.3 System Requirements 

Hardware requirements: 

• A TKH Vision GenICam-standard camera 

• Intel Core i7 or higher 

• 16GB RAM or higher 

• Min. PCIe 3.0 lane with min. 8 lanes to install your frame grabber or network card 

Software requirements: 

• Win10 x64 bit operating system 

• Driver for 10-Gigabit Ethernet network interface card or frame grabber software  

https://www.chromasens.de/gct2-current
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2 GCT v2.1 

2.1 GCT user interface 
The software provides different panel elements, they can be placed, resized, and docked freely within 
GCT window. The GCT user interface starts after the connection with a camera with the following 
setup. The window contains four main areas. The Menu bar widget for general access, the Toolbar 
widget for fast access to the most common functions, the image view widget where the image and all 
relevant information’s are displayed and the configuration widget for the camera configuration.  

 

 

2.1.1 Menu Bar  

The Start Menu offers the following functions:  

- Connect/Disconnect: Opens device discovery widget or disconnect the camera, see 2.2. 
- Start Grabbing: Starts continues image grabbing. 
- Device description: Load and save xml file from the camera. 
- Settings: GCT setting options, see 2.11 
- Exit: Close GCT window. 

The Tools Menu offers the following functions  

- Calibration: Opens a camera calibration dialog, see 2.8. 
- Maintenance Mode: Only for experts. 
- Up/Download: Opens a Up/Download dialog, see 2.7. 
- Register Editor: Only for experts. 
- Kithara Configurator: Opens the Kithara Network Configurator, see 3 

The View Menu offers the following functions  

- Default view: Set the GCT view to default.  
- Camera Configurations: Shows the configuration panel in the configuration widget.  
- Message Log: Display the Message Log under the Image view.  
- Refresh Feature Tree: Refreshes the feature tree   

The Help Menu offers the following functions  

- About: General Information’s about GCT  
- Open GCT Manual: Opens the GCT Manual  
- System Information: Generates a System information report  
- Search for GCT Update: Search for GCT updates  
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2.1.2 Toolbar widget 

The Toolbar widget contains the following icons and their functions.  

 

 

The Toolbar widget offers the following button functions:  

- Connect/Disconnect: Opens device discovery widget or disconnect the camera, see 2.2. 
- Reset and reconnect: Resets the camera and reconnect. 
- Start Grabbing: Starts continues image grabbing, see 2.4. 
- Abort Grabbing: Stops the image acquisition.  
- Acquire a single frame: Acquires a single frame.  
- Load image: Load an image from disk, see 2.6. 
- Save image: Save image to disk, see 2.6. 
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2.1.3 Configuration widget  

The Configuration widget provides two panels, Camera features which is the GenIcam parameter tree 
and the configuration panel which is a graphical representation of the GenIcam parameter tree.  

The following image shows the configuration panel of the configuration widget. The panel contains a 
tab view, from which four main categories can be selected. Each tab contains another tab view with 
subcategories. The content in each sub tab view is scrollable.  

An Info box or tooltip is shown when hovering over a parameter input field or the blue information icon. 
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The Camera Features tab contains the GenIcam parameter tree, the user setup level and an extra panel 
to set up the filter driver.  

 

2.1.4 Image view widget  

The image view widget shows the current image view and additional image and stream relevant 
information’s.  
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Mouse operations on the image 

During or after image acquisition, you can work on the image as follows. 

Function Operation 

Zoom in (factor x 1.05) Mouse wheel forward  

Zoom out (factor * 0.95) Mouse wheel backward 

Move image  Move mouse while holding left mouse button 
pressed 

Reset image to original size  
Click  

Expand image to full display area 
Click  

Read RGB value as 8bit  Move mouse onto the image 

2.1.5 Arrange / Rearrange widgets  

The software provides different widget elements, they can be placed, resized, and docked freely within 
GCT window. If you are using two monitors you can place, for example, the configuration widget on the 
second screen and the image view widget on the first screen.   

 

If you want to dock the widget again, drag the widget to the area where you want it, it will create a blue 
marked region in the target area. Once the desired position is indicated by the blue area, the widget can 
be dragged.  
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2.2 Connecting and disconnecting the camera 

To be able to access the camera, GCT needs to create a connection to the camera and to download an 
XML file that specifies the camera interface. 

To connect the camera: 

1. Switch on the camera. Initialization can take up to about 40 seconds. 

2. Start GCT. 

3. On the toolbar click Run device discovery . 

The Discovery dialog box opens and in the Discovered Devices list shows information about 
the detected camera. If the camera is not found, wait a few seconds, and then click Start 
Discovery. 

4. In the Discovered Devices list, select the camera, and then click Open. GCT now downloads 
the file with the camera interface specification, which takes a few seconds. Afterward, the 
Discovery dialog box is closed, and the available camera parameters are shown in a tree 
structure on the left side. 

 

The camera discovery is controlled by several parameters and options, which can be modified 
if necessary: 

Parameter Default value Description 

Timeout 200 msec 

If no camera can be found in the specified 
time, the discovery process stops and the 
dialog shows “No GigE Vision 

device has been found.” This 

value can be adjusted. 

Continuous Disabled 
If you select this check box, the discovery 
process is repeated until you stop it. 

Open Mode Exclusive 
Specifies how the camera should be 
opened. 

GenTL 
Producersr 

The producer(.cti) files present 
in the “GENICAM_GENTL64_ 
PATH” folders will be listed 
and selected 

Producer file, which should be used to 
detect and communicate with the camera. 
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To disconnect the camera 

After the camera is connected, the Discovery button is replaced by a Disconnect  button. Click 
this button to unlink the connection. If you want to disconnect the camera while it is grabbing images, it 
is recommended to stop the grabbing process completely before you click Disconnect. The 
disconnection progress may take several seconds, due to the cleanup of generated temporary data in 
background. 
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2.3 Modifying features 

GCT allowed to modify the features in two different ways. On the one hand, the configuration panel 
makes setting functions more convenient, special views show a set of related functions on which you 
can easily change these parameters. On the other hand, the camera feature panel allowed to edit the 
parameter in the XML-Tree  

2.3.1 In the Configuration panel  

The view consists of four main tabs Acquisition Control, Camera Image Calibration, Pixel 
Processing and Special functions. Each tab shows several subtabs. 

The Acquisition Control tab, for example, show five subtabs, which permit to specify many features such 
as image format and trigger settings: Features can easily edit in the GUI elements. Some features also 
have additional explanation pictures.  
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2.3.2 In the Camera feature panel (XML-Tree)  

On the left side of the GCT window, features and their values are shown in a tree structure organized 
in feature groups. To show the features of a feature group, click on the arrow preceding the group 
name. 

 

Some features are read-only. Their values are shown in gray color in the feature tree: 

 

Some features cannot be modified during grabbing. Therefore, their values are also shown in gray 
during grabbing. 

How values are changed, depends on the data type of the feature: 

• For binary features, select or clear the shown check box. 

 

• For numerical values, click on the value. A box and a slider appear that permit to modify the 
value: 

 

• For hexadecimal values, click on the value. A box appears that permits to modify the value: 

 

• For features containing text, a text box appears, at which you can edit the value: 

 

• For the feature type enumeration, a value list appears. Click again on the value to open the 
list, and then click the desired value: 
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• For command features, an Execute button appears: 

 

To execute the function, click Execute. 

2.4 Showing feature details 

Feature details can be displayed in the configuration panel and in the camera feature panel.  

2.4.1 In the Configuration panel  

In the configuration panel, the information is displayed when you move the mouse pointer over the 
parameter input field or the blue information icon.  

 

 

 

2.4.2 In the Camera feature panel  

To show feature details, double-click the feature name or right-click the feature and then click Display 
Feature Detail: 

 

A message box then shows information about type, access, and values: 
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2.5 Grabbing images  

To start grabbing, click Start grabbing  on the toolbar. To stop grabbing, click Stop grabbing  
on the toolbar. 

The grabbing process continues to grab images (frame) from the camera repeatedly. If only a single 

frame should be grabbed, click Acquire a single frame  on the toolbar.  

Because the filter driver can improve data processing, it should be enabled for capturing of large images.  

 

2.6 Saving/Loading an image 

GCT permits to save the currently acquired image as a BMP or TIFF file, and to load such files. 

Saving an image 

To save an acquired image: 

1. If GCT is grabbing images continuously, stop image acquisition. 

2. On the toolbar click Save currently displayed image . 

For a typical RGB8 or Mono8 format, the image can be saved as BMP file. For formats such as Mono10, 
Mono12 or RGB10p32, it can be saved as TIFF file. Each color value of each channel is then scaled 
from 10 or 12 to 16bit in the TIFF file. 

 

Loading an image from disk 

Previously saved images can be loaded back into GCT. 

To load an image: 

1. On the toolbar, click Load image . 

2. On the file dialog box, click the desired file type in the list, to display the respective images: 

 

3. Select a file, and then click Open. 

Each opened image is displayed in a separate Static Image tab. The images can be viewed with mouse 
actions, as described in section 0. The 16bit TIFF images are currently displayed as 8Bit image, so the 
RGB values are scaled to 0-255. 
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2.7 Update/Download 

Firmware files, as well as user sets and other file types, can be downloaded from the camera and saved 
to a file on the PC or vice versa. Supported file types and extensions depend on the camera type. 

2.7.1 Uploading files to the camera 

You can restore user settings, calibration files and other file types previously downloaded from the 
camera. For downloading files from the camera, see section 0 

For installing firmware files see section 2.7.1 

If you need to upload special files to the camera, contact support first. 

 

To upload files to the camera (only for Chromasens cameras): 

1. On the Tools menu, click Up-/Download, or use hotkey Ctrl+U. 

 

The Update/Download dialog box opens. 

2. Click Select Update File. A file dialog box opens. 

Select the file you want to upload and then click Open. 

GCT shows a warning message: 

 

Select the correct file type for the file you want to upload.  
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3. Click Start Update.  

GTC shows another warning message: 

 

 

     
Make sure that the appropriate file type is selected before you proceed. Selecting the 
wrong file type might damage the camera! 

Click Yes to start the upload process or No to cancel the upload. 

4. During upload a progress bar is shown. Wait until the file has been uploaded completely. 

5. Check the text in the Info Box: If the update was successful, it contains a green confirmation 
message “Update is successfully completed”  

 

 

     
If the update was not successful, do not switch off the camera, but try to restore the 
previous state by uploading the correct file for the previously selected file type. 
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2.7.2 Downloading files from the camera to the PC 

Firmware files, as well as user sets and other file types, can be downloaded from the camera to the PC 
and saved to a file. 

To download a file from the camera: 

1. Start GCT and connect the camera. 

2. On the Tools menu click Up-/Download. 

The Update/Download dialog box opens. 

3. In the Download list, click the desired file type. 

 

4. Click Download to. A file dialog box opens. 

5. Select a folder, enter a file name and extension (e.g. .bin for firmware files or .uset for user 
settings), and then click Save. 
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2.7.3 Updating the firmware 

Before you begin: 

1. Download firmware from the Chromasens website or use the firmware file provided by 
Chromasens. 

2. Start GCT and connect the camera. 

3. Note the Device Package Version and/or Device Firmware version of the currently installed 
firmware displayed in the Device Control feature group. 

 
To update the camera firmware (only for Chromasens cameras): 

1. On the Tools menu, click Up-/Download, or use hotkey Ctrl+U. 

 

The Update/Download dialog box opens. 

2. Click Select Update File. A file dialog box opens. 

Select the firmware file1 or packages you want to install and then click Open.  

GCT shows a warning message an selects the appropriate file type Firmware in the Update 
list. 

 

3. Click Start Update. 

 
1 For allPIXA SWIR cameras, the firmware file has the following name allPIXASWIR....bin.  
For allPIXA EVO camera the firmware file has the following name allPIXAevo_listfile….ini. 
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GCT shows another warning message:  

 

     
Make sure that the appropriate firmware file and file type is selected before you 
proceed. Selecting the wrong file or type might damage the camera! 

4. On the appearing warning message, click Yes to start the update process or No to cancel the 
firmware update. 

Depending on the file size, firmware upload may take a few seconds up to several minutes. 

5. During upload a progress bar is shown. Wait until the firmware has been uploaded completely. 

6. Check the text in the Info Box: If the update was successful, it contains a green confirmation 
message “Update is successfully completed”  

 

     
If the update was not successful, do not switch off the camera, but upload the 
respective firmware file again or upload a previous version. 

7. If the upload has been completed successfully, close the Update/Download dialog box, 
disconnect the camera, turn it off and after a few seconds turn it on again. 

This is necessary to complete the firmware update! 

8. Reconnect the camera.  

9. Check Device Package Version and Device Firmware version in the Device Control 
feature group to make sure that the camera successfully booted with the new firmware.  
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2.8 Camera calibration  

2.8.1 Creating a black-reference (DSNU) 

To create a black-reference: 

1. Switch off illumination and cover the lens with a black or dark piece of cardboard or plastic so 
that there is no light on the sensor. Check that the piece covers the whole lens. 

2. Prepare an image with GCT. Either click the Acquire a single frame  on the toolbar, or 

click Start grabbing , wait until an image is shown and then click Stop grabbing . 

3. On the Tools menu, select Calibration, and then click Generate DSNU Reference. 

 

The Create DSNU Reference wizard opens. 

4. On the Select image source page, click Use grab view image, and then click Next Step. 

 

5. On the next page, click at the first step (1) Set ImageCalibrationMode…), then at the second 
step, and at last at the third step.  

 

6. If all three steps were reported as successful, click Next Step. The DSNU Reference 
Generator window opens and shows the grabbed image in expected image calibration mode. 



 

GCT 22 

 

7. In the Settings for Average Value, enter values for Y-Position and Height to specify the 
area to be used for reference generation, or click Start 2-Click-Selection and click start and 
end position on the image. 

8. To create and save the reference data, click Save DSNU File to Local PC, specify folder and 
file name in the appearing file dialog box, and then click Save and close the wizard. 

9. If you are using the configuration panel to load and activate the DSNU, you can skip the next 
steps. Therefore, click Upload DSNU data-set and load the xx.dsnu data file. After loading the 
data-set you can activate the DSNU look-up table x. 

 

10. On the Tools menu click Up-/Download, and in the Update/Download dialog box click 
Select Update File. A file dialog box opens. 

11. Select the DSNU file, and then click Open. GCT selects the appropriate file type in the Update 

list. If the file type is correct, confirm the appearing warning message. 

12. Click Start Update, wait until the file has been uploaded completely, and then close the dialog 
box. 

13. To activate DSNU, click the LUT Control feature group, 
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14. Click LUT Selector and click the respective DSNU LUT in the value list: 

 

15. At the LUT Enable feature, select the check box. 
 

To create a dark-reference from an existing image file: 

1. Perform steps 1 to 3 of the above procedure. 

2. On the Select image source page, click Load image from storage, and then click Next 
Step.  

3. Click Choose BMP or TIFF File on the following page and open the desired image file in the 
appearing file dialog box. 

4. Specify a pixel offset, and then click Next Step. 

5. Continue with step 7 of the above procedure. 
 

NOTE: 
Make sure that the used image has been grabbed with active image 
calibration mode for DSNU, so that all gains and other LUTs are adjusted to fit 
the calibration. 

 
 

NOTE: 
While Image Calibration Control is active, the temporarily modified features 
are locked and cannot be modified until the feature is set to Off. 

Currently, the input image (regardless of whether acquired directly with the 
grabbing process or loaded from PC) will be converted to 8 bit and then used 
to calculate the DSNU reference. 
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2.8.2 Creating a shading reference (PRNU) 

To create a shading reference: 

1. Check lighting and focusing. 

2. Disable continuous white-control and save the parameters to the camera. 

3. If possible, prepare a moving white target. If you use a stationary target, place the target a bit 
out of focus, to reduce the effect of dust or scratches on the calibration result. 

4. Prepare an image with GCT. Either click the Acquire a single frame  on the toolbar, or 

click Start grabbing ,wait until an image is shown, and then click Stop grabbing . 

5. On the Tools menu, select Flat-Field Correction References, and then click Generate 
PRNU Reference. 

 

The Create PRNU Reference wizard opens. 

6. On the Select image source page, click Use grab view image, and then click Next Step. 

 

7. On the next page, click at the first step (1) Set ImageCalibrationMode…), then at the second 
step, and at last at the third step.  
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8. If all three steps were reported as successful, click Next Step. The DSNU Reference 
Generator window opens and shows the grabbed image.  

On the next page, shading parameters must be specified in the PRNU Settings area on the 
right side: 

 

9. Specify the target value for white, and the area that should be used to create the shading data: 

Target Value: Target value of white after the shading reference has been applied. The default 
target is 255, to obtain the full range of the camera (8bit 255). The adjustment of Brightness 
should be performed in the next step with brightness and contrast, which can be found in the 
Analog Control feature group. .If necessary, the target value can be set to a smaller value. 

Y-Position, Height: Start and height of the area used to generate shading data. If you specify 
100 and 300 as values, 200 lines starting at line 101 are used. Enter values into the boxes, or 
click Start 2-Click-Selection, and then click on the start and end position of the desired area 
on the image. The specified area is then marked with green color. 

10. If the image has black borders on the left/right side, specify an area for extrapolation: 

For extrapolation on the left side, select the Left check box, for the right side, the Right check 
box. In the Left and Right boxes, enter the start positions of the areas used for extrapolation, 
and in the Width box the width of the areas. 

Start and end position of the areas are marked with red color on the image. 

11. To show the result of the shading correction with the specified parameters, click Test PRNU. 
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12. To save the shading reference data, click Save PRNU File to Local PC, specify folder and file 
name in the appearing file dialog box, and then click Save and close the wizard. 

13. If you are using the configuration panel to load and activate the PRNU, you can skip the next 
steps and go to step 20. Therefore, click Upload PRNU data-set and load the xx.prnu data 
file. After loading the data-set you can activate the PRNU look-up table x. 

 

14. On the Tools menu click Up-/Download, and in the Update/Download dialog box lick Select 
Update File. A file dialog box opens. 

15. Select the PRNU file, and then click Open. GCT selects the appropriate file type in the Update 

list. If the file type is correct, confirm the appearing warning message. 

16. Click Start Update, wait until the file has been uploaded completely, and then close the dialog 
box. 

17. To activate PRNU, click the LUT Control feature group. 

18. Click LUT Selector and click the respective PRNU LUT in the value list. 

li 
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19. Click LUT Enable and select the check box. 

20. At the Analog Control feature group, adjust Brightness and Contrast to reach a value of 
about 220-230 in the image (8bit), for example with a brightness value of about 0.9. 

 
To create a shading reference from an existing image file: 

• Perform the steps of the above procedure, but click Load image from storage in step 6, 
click Next Step, click Choose BMP or TIFF File on the following page, and open the 
desired image file in the appearing file dialog box. 

NOTE: 
Make sure that the used image has been grabbed with active image 
calibration mode for PRNU, so that all gains and other LUTs are adjusted to fit 
the calibration. 

 

NOTE: 
While Image Calibration Control is active, the temporarily modified features 
are locked and cannot be modified until the feature is set to Off. 

Currently, the input image (regardless of whether acquired directly with the 
grabbing process or loaded from PC) is converted to 8 bit and then used for 
calculating the PRNU reference 

2.9 User level 

Each camera contains an XML file specifying the available camera features, When GCT connects to the 
camera, it loads the XML file and shows the features as a tree structure. 

Each feature has a visibility level. While all features are displayed for user level Developer, many 
advanced features are hidden for user level Beginner.  

The User Level is shown above the feature area. To modify the user level, click the displayed User 
Level, and then click the desired level: 

 

2.10 Show message log 

To show the message log, click Message Log on the View menu or click Show message log window 

 in the bottom right corner of the GCT window. A Message Log area is then shown below the image 
area: 

 

To copy messages to the clipboard, mark the messages, right-click on the selected messages, and then 
click Copy on the appearing context menu. 

To copy all present messages, right-click on the Message Log area, click Select All on the appearing 
context menu, and then press Ctrl+C. 
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2.11 GCT Options 

To open the Options dialog box, click Settings on the Start menu. 

 

Option name Default value Description 

Wait for image timeout 30000 If the next image is not received after the specified 
time, then it will send a timeout. 

The value can be modified. When GCT is restarted, it 
is set back to 30000. 

Heartbeat timeout 3000 Read the value of GevHeartbeatTimeout from the 
camera (control channel). 

Data Stream Buffer Count 5 Specifies the number of buffers used for each stream. 
The value should be at least 2 or 3. 

Ignore Image Timeout Not selected Can be selected if the acquisition process should 
continue despite timeout error. 

Display Corrupt Image Not selected Can be selected if an image should be displayed 
despite missing data 

Stops If an Error Occurs Not selected  

Draw  All Can be set to display every x frames, or to shut off 
display to reduce CPU usage. 

Enable XML feature 
caching 

Not selected So that the actual value is retrieved directly from the 
camera, instead of from a cached register. 

The options (except Wait for image timeout and Heartbeat timeout) are saved in GCC.ini in a 

user-specific folder: 
C:\Users\USER_SPECIFIC_FOLDER\Documents\Chromasens\GCT2\GCC.ini. 
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3 10 GigE interface with Kithara real time solution  

3.1 Introduction of Kithara RealTime 

Kithara Software was developed by the company Kithara. The real-time solution of Kithara is a 
comprehensive system library, which combines industrial automation, machine vision, hardware drivers 
and communication seamlessly, while being completely flexible and modular at the same time. In nearly 
any conceivable industrial application, Kithara RealTime can provide fast image capturing with the GigE 
Vision standard and can achieve a high real-time performance. Running Kithara RealTime requires 
dedicated CPU cores. On those reserved cores, the real-time system is booted, which, from here on, 
functions just like a separate RTOS while Windows retains its full operability on the remaining CPU 
cores. From this point on, Windows and the real-time system run simultaneously and parallel to each 
other on the same computer, without one restricting the other. 

3.2 Licensing 

A valid software license including a USB dongle is required to use the Kithara transport layer. Please 
contact Chromasens about information on licensing options: 

https://www.chromasens.de/en/distribution/contact 

3.3 Installing the Kithara Transport Layer 

The Kithara transport layer permits to communicate with GigE cameras based on the Kithara software. 
If Kithara should be used, all components shown on the Select Components dialog box must be 
installed. Therefore, click Compact installation to open the installation mode list, and then click Full 
installation: 

 

After the installation of the Kithara transport layer, the Windows system is configured to suit Kithara, 
and the transport layer file ls_tl_gev_kithara.cti and its library file 

gevKithara_kernel.dll are placed in the default folder: 

 C:\Program Files\Chromasens\GCT2\GenTL\Kithara. 

After the installation of this component, the system environment variable GENICAM_GENTL64_PATH 

is expanded with the transport layer folder from Kithara and from s2i. 

 

https://www.chromasens.de/en/distribution/contact
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Kithara locates and uses the existing network adapters. This can be configured during the installation 
of GCT in the Kithara configurator dialog if the component Kithara transport layer was selected. You 
can also skip the Kithara configurator dialog during the GCT installation and start the configurator dialog 
later in GCT. For more information of the Kithara configuration dialog, refer to the next section. 

After the Kithara transport layer has been installed, you must restart the PC. 
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3.4 System Configuration for Kithara 

If the Kithara transport layer is being installed, some system parameters are also configured for the 
Kithara application, and you must restart the PC after installation has finished. 

While you do not need to change the configuration manually, it could still be useful to take a look at the 
Kithara-related configurations. 

3.4.1 Kithara Configurator 

If the Kithara transport layer check box has been selected during installation of GCT, the Kithara 
Configurator is started during installation. Alternatively, you can start it later by clicking Kithara 
Configurator on the Tools menu of GCT. 

The configurator adds a file kithara_config.txt to the folder 

C:\Users\Public\Documents\Chromasens\GCT2, which contains the hardware IDs of the 

network adapters on which Kithara will be executed. Without this file, the Kithara transport layer is not 
able to detect the devices in GCT. The Kithara Configurator also adds the dedicated CPU cores for 
Kithara (refer to section 12.4.2) and disables Hyper-Threading (refer to section 12.4.3). The Kithara 
Configurator will prompt the system to reboot to update the changes. 

To configure the system with the Kithara Configurator: 

1. On the Introduction page, click Next. 

On the next page the current internet adapters are listed. Adapters that are connected and 
in use are shown as active; adapters that are not connected or at which the device is 
switched off are shown as inactive. 

2. If Kithara is going to be used with a single cable connection, select the corresponding adapter port 
in the adapter list, click Single Link, and then click Next. 

 

3. If Kithara is going to be used with two cables (which connect two dual ports of the same network 
adapter), select any one of the two adapter ports in the adapter list, click Dual Link, and then click 
Next. 



 

GCT 32 

 

IMPORTANT 
NOTE 

The Kithara configuration can currently be executed once before the first 
use of Kithara. After Kithara has been used at least once, the configured 
adapter port(s) are dedicated to Kithara and cannot be used from within 
Windows unless the driver is set back manually. In the Windows Device 
Manager the network adapters can be found in the Kithara System 
Device section. If the cable connection for Kithara is changed, it is 
required to reset the network adapter driver to the original Windows 
network adapter driver (so that the device can be found under Windows) 
and rerun the Kithara Configurator. 

3.4.2 Reserve dedicated CPU cores for Kithara 

If the Kithara transport layer is installed during the GCT installation, two cores of the multicore processor 
are automatically reserved for the Kithara real-time applications, while Windows and the remaining 
programs are restricted to the remaining processor cores. 

If GCT is uninstalled, the reserved processor cores are freed automatically. 

For more information about CPU reservation, refer to: 
https://kithara.com/en/docs/krts:tutorial:setupdedicated. 

3.4.3 Disabling hyperthreading 

If the processor supports hyperthreading, do not split a physical core between Windows and Kithara to 
maximize runtime efficiency. If the Kithara transport layer is installed during installation of GCT, the two 
following commands are executed during the installation in background using Powershell: 

bcdedit /set hypervisorlaunchtype off 

Disable-WindowsOptionalFeature -Online -FeatureName Microsoft-Hyper-V-All -NoRestart 

3.5 Using the Kithara Transport Layer 

1. Plug in the license USB dongle before using the Kithara Transport Layer. 

2. When you start GCT, the first step is to detect the camera. The Kithara TL can be used like 
any other producer but requires the system to be configured properly. The configuration is 
done automatically during the installation of GCT. For more information, see sections 3.3 and 
3.4. 

3.5.1 GCC.ini content of Kithara Producer 

During the first discovery process after installation, GCT fetches the paths from the system environment 
variable GENICAM_GENTL64_PATH and searches for .cti files in each of those folders. If cti 

transport layer files are found and can be parsed, the camera can be detected with the corresponding 
transport layer. This may take several minutes during the first discovery process. 

When you click Select TL Producer, the found files are shown: 

https://kithara.com/en/docs/krts:tutorial:setupdedicated
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To enable use of the Kithara transport layer, select the check box of the file 
ls_tL_gev_kithara.cti, clear the check box of the default file GEVTLS2I.cti, and then click 

OK. The discovery process is then started using the Kithara transport layer. 

If the discovery process has already been executed, the content of producer path, producer filename, 
and selected producer for the discovery are already adjusted automatically in the file GCC.ini. file. 

Therefore, if the discovery has already been executed, the file GCC.ini could look as follows in the 

block of [DefaultProducers]. 

 

• ProducerList contains the found cti transport layer files. 

• AdditionalSearchPath contains the additional search paths for cti files, which can be 

added by clicking Add Producer Path. 

• SelectedProducerList contains the cti transport layer files which are selected to be 

applied for the discovery process. 

3.5.2 Kithara_config.txt 

The file kithara_config.txt in the folder 

C:\Users\Public\Documents\Chromasens\GCT2 is created by using the Kithara 

Configurator  (see section 3.4.1). 

If only a single link is used with Kithara, this file contains the hardware ID of the chosen connection as 
single entry: 

 

If dual link is used with Kithara, this file contains two items from the dual connections, separated by a 
semicolon: 

 

3.5.3 Camera discovery with the Kithara Transport Layer 

If the Kithara transport layer file ls_tl_gev_kithara.cti has been selected in the Select TL 

Producer dialog box, and the file kithara_config.txt in the folder 

C:\Users\Public\Documents\Chromasens\GCT2 has been configured, a blue Kithara 

window may appear for some seconds during the first camera discovery with Kithara TL.: 
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3.5.4 Resetting network adapter driver back to Windows driver 

After discovering the camera with the Kithara transport layer file, the corresponding network adapter 
connections are assigned to the Kithara driver and can no longer be found in the list of normal network 
adapters in the Windows Device Manager.  

As shown in the following screenshot of the Windows Device Manager, the two entries of the dual port 
HP network adapter (HPE Ethernet 10Gb 2-port 560SFP) are not available in the Network adapters 
list. Instead, they are present in the Kithara System Devices list with the name Kithara RealTime -PCI 
Intel 10 GbE Network Controller. 

 

It is not an issue if the camera is always only to be used with the Kithara transport layer. But if the 
adapter should be used outside the Kithara application, the adapter driver must be set back to the 
original Windows driver, so that it can again be available for other windows applications. 

To reset a Kithara RealTime PCI network controller: 

1. On the Windows Settings window, click Network & Internet and on the next window click 
Change adapter options. 

2. Right-click one of the Kithara RealTime PCI network controllers, and then click Properties. 

3. Click Configure and on the next dialog box click the Drivers tab. 

4. Click Update Driver. 

5. Click Search driver on my PC and then click Select available drivers from a list of my PC. 

6. Select the suitable adapter driver and then click Continue. 
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7. Delete the Kithara config file Kithara.config.txt in the folder 

C:Users/Public/GCT2/Kithara. Otherwise, it could happen that the wrong 

configuration file is loaded during a renewed Kithara configuration. 

After these steps, the adapter (HPE Ethernet 10Gb 2-port 560SFP in this example) is 
removed from Kithara System Devices, and is again available in the Network adapters 
list: 
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3.6 Performance Test with Kithara 

When the Kithara transport layer is installed, a separate performance program is copied to the folder: 
C:\Users\Public\Documents\Chromasens\GCT2\performanceTest\withKithara. 

To run the performance test with Kithara, a Kithara-specific dongle representing the license must be 
plugged in an USB slot. If this dongle has not been delivered yet by Chromasens, contact sales or 
support. 

The performance test program with Kithara is independent of GCT. It can be started directly without any 
configuring. 

The program has the following parameters: 

• start_line_time:  Start value of camera acquisition line time in microseconds. 

• stop_line_time:  End value of camera acquisition line time in microseconds. 

• line_time_step_width: Time step from start_line_time to stop_line_time in 
   microseconds. 

• iteration_time:  Test duration of each line time in seconds (integer). 

• width:   Image width in pixels. If this parameter is not set, the current 
   width is used. 

• height:   Image height in pixels. If this parameter is not set, the current 
   height is used. 

• rgb10:   Format flag. If 0, the format RGB8 (each pixel has 24 bit) is 
   used for image acquisition. If 1, RGB10p32 (each pixel has 
   32 bits) is used instead. In case of RGB10p32, the camera 
   transfers 33.3% more image data. 

Example of a command line: 

PerformanceTest.exe start_line_time 30.0 stop_line_time 40.0 

line_time_step_width 5.0 iteration_time 60 rgb10 1 

This means, the camera uses RGB10p32 as image format, starts with an acquisition line time of 30.0 
microseconds (us), stops after 40.0us, and the step is 5.0us. With each acquisition line time, the test of 
each different line time will take 60 seconds. The running program can be stopped by pressing any key. 

When the performance program is started, Kithara searches all available ports of the PC. If the camera 
is connected with a single cable, the corresponding index must be entered as shown below. If the 
camera is connected to a dual port network adapter with two GigE-cables, the indices of both ports must 
be entered.  

In the example shown below, a dual port network adapter occupies two ports with the same identifier 
PCI\VEN_8086&DEV_10FB&SUBSYS_17D3103C&REV_01. The ports differ from each other only 

by the ending #01 or #02: 

 

So, if a camera is connected to both ports of this network adapter, then index 1 and 2 must be both 
selected to start acquisition. 
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3.7 Troubleshooting Kithara Transport Layer 

3.7.1 No camera is found during discovery 

Make sure that the license USB dongle is plugged in. Also make sure to configure the Kithara transport 
layer before use by following the steps described in the section 3.4. 

3.7.2 Discovery takes a long time to finish 

It may happen that the discovery takes a long time to finish its process without detecting the camera, 
even though the system is configured properly. In such cases, restart the system and try again. If the 
Kithara Transport layer is used to detect the camera, run the Kithara Configurator application again to 
set all the Kithara-related parameters correctly. 
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4 10GigE Connection without Kithara real time solution 
with Sphinx Lib  

 

There are six components for the installation. 

1. The first component is GCT and it is a mandatory part. 

2. The second component (NIC-10GigE-Driver-Files) copies the installer program 

for the driver files of the Intel-supported GigE network adapters (for example HPE 
Ethernet 10Gb 2-port 560SFP+ Adapter) to the PC. If your network adapter meets the 
criterion, you can select this component. 

3. If the third component (s2i Filter Driver) is selected, the filter driver batch of the 

selected version is copied to the PC. If no filter driver is installed, or an older version is 
installed, you can select this component. If the one of the listed versions of the s2i filter 
driver file is already installed, you don`t need to select it. 

4. Performance test provides a batch file that permits to test the image data transfer. 

5. Kithara Runtime and transport layer files. Select this component for installation only if the 
Kithara Realtime should be applied to the camera. For more information about Kithara, 
refer to chapter 2.11.  

6. SDK for GenICam Application. If this component is selected, the corresponding headers, 
library files, documents and sample code of SDK are installed. 

For the components NIC-10GigE-Driver Files and s2i Filter Driver, the 

required installation files are copied by default to the folder C:\Program 

Files\Chromasens\GCT\drivers if the respective component is selected.  

The s2i filter driver is normally installed automatically if the component is selected. To 
change/uninstall the s2i filter manually later or to install the NIC-10GigE driver, you must 
start the respective batch- or exe-file in its subfolder and reboot the PC as needed. In 
addition, a change in the BIOS settings is needed before the very first installation of s2i filter 
driver, as described in section 4.2. 
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4.1 System Requirements 

Hardware requirements: 

• A GenICam-standard camera 

• 10-Gigabit Ethernet network interface card (also known as 10Gb NIC) 

• 10-Gigabit fiber optical cable with LC/SFP+ connector and 2 transceivers SR 850nm SFP+.  

• Intel Core i7 or higher 

• 16GB RAM or higher 

Software requirements: 

• Win10 x64 bit operating system 

• Driver for 10-Gigabit Ethernet network interface card   

4.2 Setup of the 10-GigE adapter 

4.2.1 General preparation 

If the component s2i Filter Driver is selected during installation, it is installed automatically from the 
installer. I you want to change the filter driver manually afterwards, refer to section Fehler! V
erweisquelle konnte nicht gefunden werden.. 

 

Installing the s2i filter driver 

To be able to apply the s2i filter driver in GCT, at least version 2.4.0 of the filter driver must be 
installed (V2.5 is recommended). The batch files for installation and removal can be found in the 
folder: 
C:\Program Files\Chromasens\GCT\drivers\s2iFilterDriver. 

If an older version is installed, for example V2.1.4, it should be updated. 
 

To remove an older version of the s2i filter driver: 

1. Run the batch file UninstallFilterDriver.bat. 

2. Reboot the PC. 

3. In the folder C:\windows\system32\drivers remove the file s2iGEVFilter.sys 

if it is still present. 
 

To install the s2i filter driver: 

1. Run the batch file InstallFilterDriver.bat as administrator. 

2. Reboot the PC. 

For more information, refer to the instruction HowTo_Install_Driver_Windows.pdf in the 

folder C:\Program Files\Chromasens\GCT\drivers\s2iFilterDriver. 

 

Disabling Secure Boot 

Secure Boot must be disabled in the BIOS settings. To access the BIOS settings, you must press the 
BIOS key of your PC, while the PC is starting. The BIOS key could be F10, F2, F12, F1, or DEL, 
depending on the manufacturer of the mainboard. 
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Connecting the camera 

Connect the required Gigabit Ethernet cable(s) to the network adapter. If a teaming should be 
configured, you should connect both cables to the network adapter and then power up the connected 
camera. 

4.2.2 Setup for adapters supported by Intel driver under Windows 10 64-bit 

If the following conditions are fulfilled, the setup can be performed using a Powershell script as described 
below: 

• 10-GigE adapter supported by an Intel driver, for example HPE Ethernet 10Gb 2-port 560SFP+. 

• Windows 10 64-bit 

Otherwise, the setup of the network adapter must be performed as described in section 4.2.3. 

To setup the adapter using the Powershell script: 

1. Install the intel driver for 10-GigE network adapter manually. 

By default, the network adapter driver can be found in the folder 
C:\Program Files\Chromasens\GCT\drivers\NIC-10GigE\Win10  

if the option NIC-10GigE-Driver Files was checked during GCT installation. The 
newest driver version can be also downloaded from the Intel website under 
https://downloadcenter.intel.com/de/download/25016/Intel-Network-Adapter-Driver-for-
Windows-10. 

Double-click the executable network adapter driver to run its installation. 

2. Start Windows PowerShell as administrator. Windows 10 comes with a Cortana search box in 
the taskbar. Just type powershell in the search box. Right-click on Windows PowerShell 

on the results, select Run as administrator, and confirm with Yes. Then type the following 
row in the PowerShell console window to run the PowerShell script config10GigE.ps1: 

C:\Users\Public\Documents\Chromasens\GCT\config10GigE.ps1 

3. According to displayed hint, enter y or n, to setup for each adapter connection. 

 

If a teaming group (link aggregation) exists already, you must remove it first before 
starting a new setup. In this case, enter y. 

https://downloadcenter.intel.com/de/download/25016/Intel-Network-Adapter-Driver-for-Windows-10
https://downloadcenter.intel.com/de/download/25016/Intel-Network-Adapter-Driver-for-Windows-10
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The 10-GigE adapter connections will be listed. If only a single connection will be used, 
then chose this connection to perform the setup. 

4.2.3 Setup for adapters not supported by Intel driver or under Win 7 64-bit 

In contrast to section 4.2.2, this section is now oriented to the network adapters, which are not supported 
by Intel, or the operating system is Win7 x64. Setup depends on the adapter manufacturer. Normally 
you need to install the driver of your own 10-GigE adapter first, then set parameters with proper values 
manually, and create a teaming group if necessary. The GUI of setup can vary from adapter to adapter. 
The following setup is just an example. 
 

To setup the adapter manually: 

1. On the Windows Start menu, click Settings. 

2. In the Settings window, click Network & Internet, and then click Change adapter options. 
The Network Connections window opens. 

3. Right-click one ethernet connection of the Gigabit Ethernet network card, and then click 
Properties. The Properties dialog box opens.  

4. Click Configure, and then click the Advanced tab. The available parameters may vary and 
are depending on the adapter. 
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5. Set proper values for the relevant parameters: 

Attribute name (English) Attribute name (German)  Value 

Interrupt Moderation Interrupt-Drosselung Enabled 

Jumbo packet Jumbo Packet 9014 Byte 

Large-Send-Offload 
V2(IPv4) 

Large-Send-Offload V2(IPv4) Enabled 

Large-Send-Offload 
V2(IPv6) 

Large-Send-Offload V2(IPv6) Enabled 

Direct Cache Access Direct Cache Access Enabled 

Receive Buffers Empfangsbuffer Max (e.g. 4096) 

Flow control  Flusssteuerung Disabled 

Interrupt Moderation Rate Interrupt-Drosselungsrate Adaptive 

Low Latency Interrupts Low Latency Interrupts(LLIs) Disabled 

Transmit Buffers Übertragungspuffer Max (e.g.16384) 

Rx and Tx from Offloading 
Options 

Rx und Tx von Offload-Optionen Enabled 

Receive Side Scaling RSS (Empfangsseitige Skalierung) Enabled 

RSS queues RSS-Warteschlangen 2 

Log Link State Event Verbindungsereignis protokollieren disabled 

6. In the Network Connections window, for both 10-GigE network adapter connections, right-click 
it, click Properties, click the Network tab, and only enable s2i GigE-Vision Filter Driver and 
Internet protocol version 4 (TCP/IPv4). 
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5 CoaXPress interface 

GCT2 supports the CoaXPress interface as well. 

To use the CoaXPess interface with GCT2, please follow the installation instructions above for GCT2. 

You’ll not need to select the drivers for 10GigE in the download as well as the Kithara transport layer 
during the installation. 

 

For the Diver of the CoaXPress Framegrabber as well as the transport layer, please follow the 
instructions of the grabbers manufacturer.  

In GCT2 you have to select the GenTL Producer of the frame grabber at the Discovery instead of the 
S2i or the Kithara one. 

 

Note: tested grabbers: Euresys and Matrox. 
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6 SDK – CSGenICam 

The Chromasens GenICam SDK is an optional part of the GCT software package. It can be seen as an 
abstraction layer above the GenICam GenApi and GenTL interfaces, as shown in graphic below: 

 

It permits to write applications against the CSGenICam interface. The CSGenICam interface provides a 
set of convenience functions and additional functionalities specific to Chromasens cameras. As an 
example, it adds functions that permit to perform file transfers from/to the device. It has a slightly 
simplified interface when compared to the more abstract GenApi and GenTL producer libraries. 

For more information on how to use the SDK, including a complete API reference, refer to the SDK 
documentation.   



 

GCT 45 

7 Troubleshooting 
 

 

7.1 Possible reasons for GEV_TIMEOUT_ERROR 

Sometimes during image grabbing, there comes no image from the camera, and the message log shows 
GEV_TIMEOUT_ERROR in the bottom area. This can be caused by following reasons. 

7.1.1 Trigger mode not set correctly 

Trigger source: If there is no explicit trigger available and the camera should run in “free-running” mode, 
but the value of trigger source does not correspond to this mode, then GCT will return 
“GEV_TIMEOUT_ERROR” and cannot grab images. 

 
 

7.1.2 Filter driver not installed properly (only for 10GiGE without Kithara) 

GCT can use the filter driver developed by s2i. If the filter driver should be used for the grabbing process, 
it must be installed and enabled correctly beforehand in the adapter settings. 

To check the adapter settings, go to Start menu -> Settings -> Network & Internet. On the Settings 
window, click Change adapter options. A new dialog box opens with a list of network connections. 
Right-click the corresponding GigE Ethernet connection for the camera and then click choose 
Properties. If a teaming group is used, then right-click the teaming group and choose its attributes. 
Ensure that s2i GigE-Vision Filter Driver is selected and that the version is correct. 
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7.1.3 “Secure Boot” not disabled in BIOS settings (only for 10GiGEwithout 
Kithara) 

If the filter driver is installed properly and can also be detected, but 
“GEV_STATUS_DRIVER_READ_ERROR” appears during grabbing, it could be due to Secure Boot in 
the BIOS settings. In this case refer to section 4.2.1. 

7.1.4 Firewall is not completely allowed for GCT 

Data transfer between camera and PC requires firewall allowance. Normally, the firewall rule is 
exclusively allowed for GCT automatically after installation. 

To verify the firewall rule: 

1. On the Window Start menu, click Settings-> Update & Security -> Windows Security -> 
Firewall & network protection. 

2. Click Advanced settings and highlight Inbound Rules in the left panel. 

3. Find the rule name GCT2_x64, open its properties, and ensure that the firewall rule is allowed 
for all types: domain, private, and public. 

 

7.1.5 Reboot 

If GEV_TIMEOUT_ERROR occurs only if the filter driver is activated, you can reboot your PC to resolve 
unknown conflicts in the hardware. 
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